
Import and 
Organize Photos
Adobe Photoshop Elements 11 brings a radical 
change to the Photoshop Elements interface. It is 
quite different from anything seen in earlier versions 
of the program. Do not let the changes alarm you, 
however. Photoshop Elements has been made even 
more accessible and photographer friendly. The 
folks at Adobe wanted this version of the program 
to get full attention on making it as simple to use as 
possible, and that meant a whole new interface 
design. They had two principles in mind: clear and 
immersive. Clear meant that Photoshop Elements 
would have a clear experience for you, the user, so 
that how you would work with the program would 
be clear and direct. Immersive meant that you 
would be able to immerse yourself in whatever is 
needed as you need it to make something happen 
in the program.

Photoshop Elements is still a superb image-
processing program, and is certainly one of the best 
values for the money on the market. Photoshop 
Elements uses the exact same processing algorithms 
that Photoshop does, but the interface is now even 
simpler and set up to make it more intuitive for use. 
In addition, the Windows and Mac versions of 
Photoshop Elements Editor are essentially the same, 
and the tips in this book work the same with either 
platform except for occasional keyboard 
commands. Ctrl/⌘+click, for example, shows the 
Windows key and then the Mac key to use as you 
click the mouse.
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 The Photo Downloader dialog 
box appears.

3 Click here to select your camera 
or card reader.

4 Click Browse to select a location 
for your photographs on your 
hard drive.

5 Click here and select Custom 
Name from the menu that 
appears to create a custom name 
for a subfolder.

Importing from a Digital Camera 
or Memory Card

1 Click Import.

2 Click From Camera or Card 
Reader.

You have taken some photos and now you want to get 
them into the computer. Photoshop Elements makes that 
easy to do by both downloading your photos from a 
memory card to your hard drive and having Organizer 
recognize them at the same time. Organizer helps you 
sort, delete, and organize your photos. Organizer does not 
actually hold onto your photographs; your hard drive 
does. However, Organizer does need to know where those 
photographs are. It needs, in a sense, a map to where 
your photos are located. So by using Organizer to import 
your photos to your computer, you create that map.

When you first open Photoshop Elements, click the 
Organizer button to go into the Organizer mode. All 
importing is done through this mode.

This is a simplified way of getting all your images from the 
memory card onto your hard drive and recognized by 
Photoshop Elements. For more control over your 
importing, including importing only part of your memory 
card at a time, see the completion of this task on the next 
pages.

IMPORT your images
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Chapter 1: Import and Organize Photos 5

TIPS Did You Know?
A quality memory card reader is 

the fastest and most dependable 

way to download images. A card 

reader needs no power, can be 

left connected to your computer, 

and will not be damaged if 

accidentally knocked to the floor. 

Many computers now have SD 

card readers built into them.

Did You Know?
The Automatic Download check 

box in the Photo Downloader dialog 

box sets up your computer to 

automatically download photos 

based on criteria set in Organizer 

Preferences, found in the Edit menu 

on the PC and in the Adobe 

Photoshop Elements 11 Organizer 

menu on the Mac. This can be a 

problem because it does not enable 

you to put photos into specific 

folders for each download, nor does 

it enable you to rename photos.

Did You Know?
Most photographers prefer to put 

images into distinct file folders on 

their hard drives rather than 

lumping them together into the 

Pictures folder. Photo 

Downloader enables you to set 

up specific folders. You can put 

photos in a folder based on date 

and location, for example, inside a 

larger folder called Digital Photos 

on your desktop to make them 

easier to find if the Organizer in 

Photoshop Elements ever fails.

8 Type a new name for your photos 
if needed.

9 Click here to leave photos on the 
memory card so that your camera 
can reformat the card properly.

0 Click Get Media.

 The photos now import into your 
computer.

! When the Files Successfully 
Copied dialog box opens, click 
Yes to include them in the 
Organizer.

6 Type a name for your 
subfolder specific to the 
images you want to 
import.

7 Click here to give your 
photos a custom name, 
name them by date, or 
keep the original 
filenames.
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 The advanced Photo Downloader 
dialog box appears.

A All photos are checked to start, so 
Check All is grayed out at first.

3 Click UnCheck All to deselect all 
photos to select specific images 
for import.

4 Click the first photo of your 
group to import.

Advanced Importing from a 
Digital Camera or Memory Card

1 Repeat steps 1 to 10 from the 
“Importing from a Digital Camera 
or Memory Card” section to 
open the Photo Downloader 
dialog box.

2 Click Advanced Dialog.

Commonly, you will shoot several different subjects or 
locations on a memory card. You may not want all of 
them mixed together in a single folder. It can be very 
helpful to keep your photos separated by folders so that 
you can always find images on your hard drive, even 
without Photoshop Elements. You have the option in an 
advanced dialog box to import only the pictures that you 
want from a memory card. This dialog box is very similar 
to the Photo Downloader dialog box, but it includes some 
additional choices you should know about.

The photos being imported in this chapter are from 
beautiful country around Sedona, Arizona. This area is 
known for its combination of pine trees and red rock, 
along with the very pretty Oak Creek.

Photoshop Elements also enables you to import images 
already on your hard drive. The process is very similar, but 
does use a slightly different dialog box. This can be useful 
when you have transferred pictures directly from one 
computer to another, for example.

IMPORT your images (continued)
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Chapter 1: Import and Organize Photos 7

#1
(continued)

TIPS Did You Know?
When the Organizer recognizes 

photos, Photoshop Elements does 

not move or change them unless 

you tell it to. Photoshop Elements 

is simply creating a map to these 

image files on your hard drive so 

that it can find and organize the 

photos as needed.

Try This!
Use the Light Bulb icons. 

Photoshop Elements scatters tips 

throughout the program to help 

you when you do not understand 

a particular control or option. 

Click the icon and a tip appears, 

providing information on how to 

use the control or option.

Did You Know?
Having your name and copyright 

information on a photo helps 

people keep track of your photos. 

Even if you are not a pro, having 

your name in the metadata means 

that if you give your photo files to 

someone, such as for an 

organization’s brochure, everyone 

can know whose photos they are.

8 Click here to open the Apply 
Metadata section if it is not 
already open, select Basic 
Metadata, and type your name 
for the Creator and Copyright 
text boxes.

9 Click Get Media.

 The photos now import into your 
computer.

0 When the Files Successfully 
Copied dialog box opens, click 
Yes to include them in the 
Organizer.

5 Scroll down to the last 
photo in the group.

6 Shift+click that last photo 
to select all photos from 
the first one to this one, 
but no others.

 Ctrl/⌘+click isolated 
photos to add or remove 
them from the group.

7 Click the check box 
under any image to 
check all that are selected 
(  changes to ).
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 Your folder display changes to 
show you folders as they are 
arranged on your hard drive.

4 Click Hide Panel to hide the panel 
on the left.

5 Click Instant Fix to hide the 
Instant Fix panel.

 Imported images first appear in 
the Media screen.

1 Click My Folders to see all your 
photographic folders in 
alphabetical order.

2 Click Sort By to change how 
images are displayed.

3 Click the small folder icons next 
to My Folders.

The Organizer in Photoshop Elements makes it easy for 
you to review many photos at once and in many ways. 
This latest version of Organizer simplifies access to how 
you display and work with images so that you do not 
always have to go to the menus at the top. The previous 
task showed a good example of this where for importing 
you simply go to a button called Import.

Removing the panels at the left and right sides lets you see 
multiple images across your screen, so you can quickly 
make comparisons among them. This can help you check 

out your latest photo shoot as well as visually find 
important images. It can also be a great learning 
experience as you look to see what you did over time as 
you took pictures.

Of course, you should look at single images at a larger 
size. Seeing larger images enables you to find the best 
photos, whether it means checking sharpness, focus, a 
person’s expression, and so on. The photos seen here are 
from Slide Rock State Park near Sedona, Arizona.

Use the ORGANIZER INTERFACE
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Chapter 1: Import and Organize Photos 9

TIPS Did You Know?
The full-screen view can be used 

as a slide show. Click the center 

arrow of the bottom toolbar to 

start playing images or pause the 

slide show. You can change how 

long each image is on the screen 

as well as play music with the 

photos by clicking the Wrench 

icon, which gives you settings to 

try. You can play this slide show 

only when the Photoshop 

Elements Organizer is open.

Try This!
The Timeline in Photoshop 

Elements can help you find photos 

by date. You can turn it on in the 

View menu. It works for the entire 

database, so click the Show All 

button at the top left of the 

thumbnails first and then select a 

specific time; photos from that 

time period appear below. You 

can also drag the left and right 

sliders to limit the dates to show 

images.

Did You Know?
The Instant Fix panel in the 

Organizer can be a useful way to 

quickly make adjustments to your 

photos. Click the Instant Fix icon 

at the bottom of the interface to 

open or close this panel. Then 

choose controls that enable you 

to adjust your photo.

 The photo now displays large in 
the interface.

8 Click the arrows above the photo 
to move to the next or previous 
photo.

9 Double-click the photo again to 
go back to the Grid view.

0 You can also click Grid to go back 
to Grid view.

 Your interface changes 
to show you a nice 
display of your images 
as if they were on a 
light table. This is called 
the Grid view.

6 Click and drag the 
Zoom slider to make 
the images larger or 
smaller.

7 Double-click any image.
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4 Click the View menu and then 
Details to show or hide Details.

A Details show up under the 
photograph and show ratings 
stars, date and time, and 
filename.

5 Click the stars to rate your 
photos.

 You can use a system such as one 
star for those photos you reject, 
five stars for the best ones, and 
various numbers of stars in 
between to define how much you 
like or dislike particular photos.

Set Up Your View of the Photos

 Leave the left and right panels 
hidden.

1 Click and drag the thumbnail 
slider to change the sizes of your 
photo thumbnails.

2 Ctrl/⌘+click photos to select 
images that you want to rotate.

3 Click the appropriate Rotate icon 
to rotate the selected photos.

Traditionally, going through your pictures, finding the 
good ones and getting rid of the bad, has been called 
photo editing. However, when computer engineers 
developed programs like Photoshop, they decided to call 
changing pictures in those programs photo editing, too, 
so the term can be confusing.

Still, one of the most important things you can do with 
your photographs after importing them into Photoshop 
Elements is to go through them and edit them based on 
the original definition of the word. This is a great 

opportunity for you to learn from both your successes and 
your mistakes.

Photoshop Elements gives you some excellent tools to do 
just that. You can compare pictures, look at pictures in 
different sizes, and discover which pictures work well for 
you and which do not. A great advantage of digital 
photography is that it is easy and inexpensive to take 
multiple shots of a changing scene, such as the waves 
coming onto a beach, or some variation in composition.

SORT THE GOOD PICTURES from the bad
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TIPS Remember!
Do not be stuck with too many 

photos cluttering up your hard 

drive and your mind. You have the 

choice of deleting images from 

Photoshop Elements and/or off 

your computer altogether. If you 

really do not like certain images, 

avoid keeping them just because 

you do not like deleting photos. 

Get rid of photos you consider 

junk. Choose Also Delete Selected 

Item(s) from the Hard Disk.

Did You Know?
You can control many features of 

Photoshop Elements with 

keyboard commands. These 

enable you to quickly access 

controls with just a couple of 

keystrokes. These keystrokes are 

listed next to the controls in the 

menus. For example, you can turn 

on and off the detail display for 

thumbnails by pressing Ctrl/⌘+D.

Did You Know?
You can turn off the view of 

filenames using the View menu. 

Click View and then select or 

deselect filenames. Clicking Details 

on or off turns on or off 

everything under the photo, 

including filenames.

 The Confirm Deletion from 
Catalog dialog box appears.

0 Select the Also Delete Selected 
Item(s) from the Hard Disk check 
box to throw out your rejects.

 Make sure the Also Delete 
Selected Item(s) from the Hard 
Disk check box is deselected to 
remove photos only from the 
Organizer and not the hard drive.

! If you feel that you made a 
mistake, you can click Cancel and 
change the ratings.

@ Click OK to finish the process.

# Click All Media to get your 
photos on-screen again.

Delete Photos You Do 
Not Want

6 Click one rating star in 
the upper right of the 
thumbnail display if you 
have used a one-star 
rating for images you 
want to delete.

7 To limit displayed 
photos to only those 
with one star, click the 
modifier to the left of 
the stars and select the 
equal sign.

8 Select all photos with 
Ctrl/⌘+A.

9 Press Delete.
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3 Click Edit.

4 Select Stack.

5 Select Stack Selected Photos.

1 Click the first image of a group 
that could be stacked.

2 Shift+click the last image of that 
group.

 The whole group is now selected.

Once you own a digital camera and a large memory card 
or multiple cards, taking pictures costs nothing. This 
means you can freely photograph a subject, trying 
different angles or varied techniques. However, as you do 
this, you accumulate a lot of similar photos in your digital 
files. That can make working with a particular group of 
photos more challenging because you have to look at a lot 
of similar images before you come to the new ones.

Stacking enables you to place special subgroups of your 
photos into stacks that are then displayed as if they were 

one image. This can simplify the view of your photos in 
Organizer. You can also use stacks to keep a particular 
small group of photos together.

In the group of images that were imported on these pages 
are a number of images that show reflections in the water 
of Oak Creek in Sedona. The photos are similar enough 
that they are worth grouping as a stack. Stacks are tools to 
help you better organize your photos as you go through 
them.

STACK your images
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TIPS Did You Know?
You may want to simply hide 

some photos to simplify what you 

see in Organizer rather than 

stacking them. Some photos you 

may want only as a reference, so 

you do not want to delete them 

or remove them from Organizer. 

To hide a photo, go to the Edit 

menu, select Visibility, then Mark 

as Hidden. You can make hidden 

files visible or not appear in the 

same menu.

Try This!
You can also use stacking to 

simplify and organize your 

thumbnail view. For example, you 

could stack photos of each child at 

a birthday party so that the entire 

group of party photos is organized 

into stacks based on individuals. A 

Ctrl/⌘+click isolates photos to 

select them.

Did You Know?
Stacking is simply another method 

to group photos in a way useful to 

you. It is based on an old 

technique slide shooters used 

when sorting photos. They would 

pile similar slides on top of each 

other, making stacks that kept 

their light tables better organized.

B The stack opens and is 
highlighted as a group.

C The Stack icon shows on the first 
image of the group.

7 Click the small arrow at the 
middle of the right side of the last 
photo to collapse the stack again.

 The images are visually 
stacked so you see only 
one.

A The Stack icon appears 
in the upper right 
corner of the stack to 
inform you it is a stack. 
You will also see text 
saying “Photo Stack.”

6 Click the small arrow at 
the middle of the right 
side of the photo 
thumbnail.
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Back Up to an External Hard 
Drive

1 Click Show Panel at the bottom 
left to reveal the Folders panel.

 An external hard drive is one of 
the best ways to back up the 
images on your computer’s hard 
drive.

Digital photos are vulnerable to loss from a hard drive 
failure — and hard drives do fail. There is a saying in the 
computer industry that it is not if, but when, a hard drive 
fails. Plus, without a hard copy, you have no other record of 
the images. By backing them up, you can add more security 
to your pictures than is possible with traditional film.

Having your images only on the single main hard drive of 
your computer is asking for trouble. Not only are they at 
risk of becoming totally lost if that drive fails, but that 

drive is then more likely to fail because everything on your 
computer uses it constantly. Plus the added stress of 
always accessing images increases the potential of that 
drive failing. That is why many photographers prefer to 
put their photos on an accessory hard drive and then back 
up that drive to a second accessory hard drive. These 
drives plug into a USB, FireWire, eSATA or Thunderbolt 
port and have come down so much in price that they truly 
are a small cost to preserving your images.

BACK UP YOUR PICTURES to protect them
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TIPS Did You Know?
Backup software can make your 

backups easier. Once you set up 

backup software for specific 

folders and a specific accessory 

drive, the software remembers 

those locations. The next time 

that you ask it to back up, it simply 

compares files in those two 

locations and adds only what is 

new. Check out Second Copy for 

Windows at www.centered.com 

and Déjà Vu for Macs at www.

propagandaprod.com. 

Did You Know?
Photoshop Elements Organizer 

now includes a backup function in 

the File menu that enables you to 

back up the catalog and files. Some 

people like how Adobe has set this 

up and some people do not. 

Specific backup software can make 

this easier, but it does not back up 

the catalog of Organizer. The 

catalog holds the organizing 

database for Photoshop Elements.

Try This!
You can create a duplicate file 

structure on your backup drive 

that matches your main computer 

in order to make your backups 

simpler. Simply create folders and 

levels of folders that include the 

files you want to back up that are 

the same on both. For example, if 

your photos are structured by 

year and then by specific event, 

use the same year and event 

structure. Then you can simply 

copy a folder from one drive to 

another in the same filing setup.

Use Backup Software

Note: You can obtain special 
backup software to help you with 
backing up your photos. All these 
programs work slightly differently, 
though the steps are similar.

1 With your backup software open, 
choose the folder or folders you 
want to back up.

2 Select the location for backup.

3 Select when to make the backup.

4 Click Finish to start the backup.

 The backup software saves the 
folder or new images in the folder 
to the designated location at the 
time you specify.

2 When the left panel 
appears, choose the 
Folders view.

3 Click the folder you 
want to duplicate.

4 Drag the folder to the 
external hard drive.

 On a PC, the external 
drive may appear only 
as a letter. Use Windows 
Explorer to find which 
letter your drive 
represents.

 The folder is saved on 
the external hard drive.
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3 Click the Instant Fix adjustment 
icon you want to use.

 If your image is a JPEG file, 
Instant Fix duplicates that file and 
immediately starts to apply the 
adjustment.

A RAW files cause a dialog box to 
open for you to choose the file 
format for the new image file.

4 Choose a file format. Use 
Photoshop if you think you might 
work on this new file later in 
Editor. Use JPEG if you want a 
small file to use for e-mail or 
other purposes.

5 Click OK.

1 Click Instant Fix to open the right 
panel.

2 Select an image to work on. 
Double-clicking the image 
displays it large.

Instant Fix is a very useful tool to help you quickly and 
easily get automated adjustments of your photos while still 
in Organizer. This panel offers you one-click adjustments 
for a number of key photographic controls. These 
adjustments are not going to be optimum for every photo 
because they are automated, but they can be a fast way of 
getting an acceptable adjustment to an image that you 
can quickly use to make a fast print or to post to 
Facebook.

A nice thing about Instant Fix is that no adjustments 
change your original image. A new, duplicate image file is 
created for JPEG files automatically, and for RAW files, a 
specific new file is created with a file type of your choice. 
Each time you click a new control, you get a new file. 
Smart Fix uses all the automated options in Smart Fix at 
once for just one new file. Sometimes that is best, but 
sometimes you do not need or want all those adjustments 
made.

Use INSTANT FIX
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TIPS Did You Know?
RAW files can never be changed 

and must be converted to a file 

format such as JPEG, TIFF, or 

Photoshop to be used for anything 

outside of Photoshop Elements. 

RAW files hold more image 

information than JPEG files, useful 

when working on them in Camera 

Raw, which comes with Photoshop 

Elements, but they have little 

advantage in Instant Fix.

Try This!
A great way to photograph in a 

canyon or valley is to get there 

early when the light is on the 

canyon walls, but not on the 

stream or creek below. That is 

what you see here. This creates 

interesting reflections in the water 

that contrast with the shadowed 

surroundings. Use Shade white 

balance and be careful you do not 

overexpose the reflection.

Try This!
If you are not sure exactly what an 

adjustment will do to your photo, 

and they are hard to predict 

because they are automated, try it 

and see. This hurts nothing 

because your original image is 

untouched. If you do not like the 

adjustment, just delete it.

B The new image appears stacked 
with the original when seen in 
the Grid view.

C The Instant Fix icon appears at 
the top right of the photo to let 
you know the image has been 
adjusted.

D The file has a name based on the 
original with _edited-(number) 
added.

6  A small window appears 
informing you that the 
processing is being 
done.
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1 Click Show Panel at bottom left 
to show the left panel. The screen 
shows Hide Panel because the left 
panel is visible.

 Hide the right panel by clicking 
the Instant Fix icon at the bottom 
to give more room for your 
photos to display.

 Click Grid to show thumbnails of 
photos if you have a single image 
displayed.

2 Ctrl/⌘+click photos to select 
individual images, or click a 
photo and then Shift+click the 
last image in a group to select 
photos in order.

 Optionally, press Ctrl/⌘+A to 
select all photos.

3 Click the large green plus sign to 
the right of Albums and select 
New Album to add an album.

A The Add New Album panel 
appears.

4 Type a name for your album.

5 You can group albums by using 
the Album Category function, but 
start with None (Top Level).

B Your selected photos appear in 
the Content box.

6 Click Done.

Albums are a very useful way of grouping your images so 
you can find particular photos later. You can create an 
album of specific images from a particular event such as a 
trip, or you can create an album based on a subject that 
shows up in many places in your photography. Albums are 
not specific to any folder of images that you have 
imported. For example, for the photos shown in this 
chapter from Sedona, Arizona, you could create an album 
on just the latest trip there, or you could include images 
taken at other times you had been there. As another 

example, you could create an album related to just 
reflected scenes that could begin in Sedona and expand to 
any place you went that had water that might reflect the 
landscape.

Albums do not duplicate photographs. They only create 
references to where the pictures are on your hard drive. 
For that reason, individual pictures could be in many 
albums, which can help you find them faster in different 
ways.

CREATE ALBUMS to group your pictures
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TIPS Did You Know?
You can add photos to an album 

at any time. Whenever you see a 

photo that belongs in an album, 

click it and then drag it to the 

album. The photo is automatically 

placed in the album and appears 

there whenever that album is 

open. Remember you are only 

creating references to photos and 

not actually moving any.

Try This!
You can immediately put any new 

photos just imported into 

Photoshop Elements into an 

album. Select all images in that 

new group of photos, add an 

album with a name appropriate to 

that group, and the photos should 

appear in the Contents box. If not, 

select and drag the new pictures 

into that Item box.

Smart Albums!
You can create a Smart Album 

that automatically adds photos to 

the album. You set up criteria, 

such as filenames, keywords, and 

camera type, in the New Smart 

Album dialog box, which you 

access by clicking the Albums plus 

sign. Any photo with those criteria 

appearing in Photoshop Elements 

is automatically included in the 

Smart Album.

so. This is called secondary click in 
System Preferences. 

9 Click Sharing for sharing options.

 After processing the images for 
sharing, Organizer displays a new 
interface to allow you to share your 
images by exporting your photos as 
an album.

0 Choose a template for the album.

! Use the slide show controls to see 
how the album plays as a slide show 
and to change slide show settings. 
This is only available for PCs. 

 The new album now appears 
in the Albums panel after 
Organizer builds its preview 
images.

7 Click Albums to show the 
albums if they do not 
appear.

8 Click an album to select it.

 Remove photos from your 
album by right-clicking the 
photo and selecting Remove 
from Album from the 
context-sensitive menu that 
appears. Set up your Mac to 
use a right-click with your 
mouse if you have not done 
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3 Select an album to find people in.

4 Go to a photograph of a person 
in the Grid view and double-click 
it to make it large.

5 Be sure People Recognition is 
turned on in the View menu.

B A box appears over recognized 
faces.

6 Click Who Is This? and type a 
name.

 After typing a name, press Return 
or Enter.

1 Click People view to show any 
people that have been identified 
in your photos.

A People appear in stacks of 
photos.

2 Add people to People view by 
going back to Media view.

People are an important subject for most photographers. 
Friends and relatives are photographed in all sorts of 
settings. And today, digital cameras are so much a part of 
family life that parents and grandparents are constantly 
shooting all members of the family, especially the kids. 
This can result in a lot of images containing many people, 
but those images can be hard to find later. It would be 
nice to just be able to isolate one person’s photos out of 
the mass of images on your hard drive.

Photoshop Elements offers a handy way of dealing with 
people through its People view. This view lets you find 
specific people in different folders long after you even 
remember taking those images. Once you have located 
and named the people, Organizer puts that information 
into its database so you can access it in the People view. 
People view acts like every other view in Organizer in that 
you can hide and reveal panels at the left and right, use 
Instant Fix, show images single or in a grid, and so on.

Work with PEOPLE VIEW
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TIPS Important!
Set up your Mac to use a right-click 

with your mouse if you have not 

done so. The latest Apple mouse 

does allow right-clicking if you set it 

up through System Preferences 

using secondary click. You can also 

purchase different designs of right-

click mice. Photoshop Elements has 

many right-click menus that are 

more easily accessed in this way. 

Otherwise, you have to press the 

Control key while clicking, which is 

much less efficient and can lead to 

mistakes.

Did You Know?
If a photo contains more than one 

person, Organizer provides 

additional boxes to allow you to 

identify them, too. Each person 

will have a unique stack in People 

view even if he or she appears in a 

photo with other people. If no box 

appears, click the Missing People 

icon at the bottom of Organizer 

to get one.

Did You Know?
Right-click any photo in any view 

and you get a context-sensitive 

menu specifically related to 

working with pictures. As you 

identify a person in different 

pictures, in different folders, you 

might not remember what folder a 

specific picture in People view is 

from. Right-click and look for a 

menu choice that goes back to the 

folder.

7 Click the arrow above the 
picture to move to the next 
image or use the arrow 
keys on your keyboard.

8 Click and drag the 
recognition box to better 
highlight the face.

9 Click and drag the corners 
of the box to size it better 
for the face.

C As you type a name, 
Organizer gives you a 
recommendation. Use the 
down-arrow key on your 
keyboard to select it.

0 Click the green check mark 
or press Return or Enter on 
your keyboard.

! Click People to show the 
People view.

D A new stack of people 
photos appears with the 
person’s name.
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A The stack opens as Faces or 
Photos, depending on how it was 
last seen.

B Faces displays just the face of the 
person identified from the photo, 
even if the original image had 
lots of faces.

% Click the switch to slide it from 
Faces to Photos.

@ Move your cursor slowly across a 
stack, without clicking, to display 
the images in the stack.

# Right-click when you get to an 
image you want, then use the 
context-sensitive menu to remove 
it, rename it, or select it as the 
profile photo for the stack.

$  Double-click the stack to open it.

People view can offer you the ability to isolate every 
person you have ever photographed into individual stacks 
so that you can always find photos of them throughout 
your files. That is the good news. The bad news for some 
photographers is that to do this, you have to take the time 
and go through every photo, identifying the individuals so 
that Organizer can put them into People view. People 
view is a database, and databases work only when you are 
willing to put in the time and effort to build that database.

People view also enables you to group people into groups 
such as family or friends. Move the slider at the top of the 
stacks view in People from People to Group to reveal a 
Group panel on the right. Drag any stack to any group to 
add a person to a group. Once you do that, the Group 
interface of People shows your stacks as ungrouped or in 
what group they reside. Double-click a group icon in the 
Group panel to reveal stacks included in that group.

Work with PEOPLE VIEW (continued)
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TIPS Important!
To add a specific group to the 

Group mode of People view, open 

the Group panel on the right. This 

is available only when you are 

looking at multiple people stacks. 

Next, click the green + arrow that 

appears in the panel. Type a name 

for the group in the dialog box 

that appears, and choose to make 

this its own group or part of 

another group. Click OK.

Did You Know?
The picture on the stack of people 

photos is called the stack profile 
picture. It is based on the box that 

outlined your person when you 

first identified him or her. Change 

the position and size of that box as 

you identify the person to get a 

better profile image later.

Did You Know?
Groups, Albums, and Views are all 

simply ways that Organizer offers 

you to better organize your 

photos. None of these groupings 

changes your photos or moves 

them in any way on your 

computer. These are essentially 

“virtual groups” that Organizer is 

using to help you separate and 

define your photographs into 

manageable groups.

 The photo appears as a single 
image filling the Organizer image 
area.

C The people recognition box 
appears around the person’s face 
with his or her name so you can 
find the face in a crowd if 
needed.

 Whole photos now 
appear from the 
person’s stack.

^ Double-click any photo.
8

(continued)
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 Nothing appears in Places until 
photos have been placed on a 
map.

3 Click Add Places.

1 Click a folder to display its images 
in Media.

2  Click Places.

Global positioning system, or GPS, uses satellites to allow 
you to pinpoint your location anywhere in the world. You 
can use GPS units and even your smartphone to determine 
your coordinates so you can return to a location later or to 
search for a specific location. This has made people far 
more aware of where they are as they travel.

Although you cannot access GPS satellites with Photoshop 
Elements, you can pinpoint locations of your photos 
anywhere in the world with Places view. This section of 
Organizer must be able to connect with the Internet in 

order to use it because it needs to access a world database 
of Google maps. You can then pinpoint your photo 
locations on that map so that later you can always use that 
as a reference as to where you were.

The photos seen here were taken at the Petrified Forest 
National Park near Holbrook, Arizona. This is a striking 
location of high desert, rainbow-colored hills, and of 
course, the remains of an ancient forest, now preserved in 
rock.

Work with PLACES VIEW
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TIPS Did You Know?
You do not have to start in Media 

view to work with Places view. 

You can access folders when you 

are in Places. However, it is a little 

disconcerting to go to Places and 

see no images when you first open 

a folder and no images have been 

placed on a map. By going to 

Media view first, you can look at 

your images and get an idea of 

what you have there before you 

start working with a map.

Did You Know?
Google Maps is often used by 

people exploring the Internet to 

find specific locations around the 

world. This includes an extensive 

database of maps that show 

everything from an overview of 

the entire planet down to the 

house and street where you live. It 

is used by many businesses, such 

as Adobe for Photoshop Elements, 

to provide an interactive map 

service.

Did You Know?
The Petrified Wood National Park 

is an unusual location in 

Northeastern Arizona right off of 

I-40. Parts of the park offer trails 

through ancient forests, but all the 

trees look like they have been cut 

down and chopped into sections. 

Over a very long time, colorful 

minerals have seeped into the 

wood, making it a rock that still 

has a wood-like appearance.

5 Click the location you want.

 Otherwise, simply press Enter or 
Return when you finish typing 
your location.

 The map now shifts to display the 
searched-for location.

B A green arrow marks the 
searched-for spot.

6 Use the Google map resize 
controls to resize the map to help 
find your photo location.

7 Use the Google map position 
controls to move the map 
around. You can also click and 
drag on the map to do this.

 A map now appears 
along with a filmstrip of 
images above it. The 
filmstrip is based on the 
folder you selected at 
the left.

4 Type in the search box 
a place where your 
photographs were 
taken. This can be a 
nearby town.

A As you type, and 
depending on the 
speed of your Internet 
connection, you get a 
list of suggestions.

03_9781118380857-ch01.indd   2503_9781118380857-ch01.indd   25 9/25/12   2:26 PM9/25/12   2:26 PM



26

9 Ctrl/⌘+click photos to select 
individual images, or click a 
photo and then Shift+click the 
last image in a group to select 
photos in order.

 Optionally, press Ctrl/⌘+A to 
select all photos.

0 Click and drag the selected 
photos to place them on the 
map.

 Your map now should clearly 
show your location.

8 Size your map so that you can 
see the location well enough to 
place your photos. Sometimes in 
natural areas without roads, 
Google maps does not give 
enough references for you to 
place your photos if the map is 
enlarged too much.

This can be a fun way to interact with your photos after a 
trip. You can relive where you went as you place your 
photos on the map. Images can be placed individually at 
precise locations or as groups at a more general meeting 
spot or anything in between. It is up to you.

You can place your photos in extremely accurate positions 
on the map or just attach them in a general location. This 
depends on how large you blow up the map as you work 

with locating your camera position when you took the 
pictures. Places always puts a marker on a very specific 
location, so if you want to be totally accurate, you need to 
blow up the map to a level that lets you do that.

You must decide how much time you want to spend 
doing this map work. Just like working in People view, you 
can spend a lot of time here, and that does not appeal to 
all photographers.

Work with PLACES VIEW (continued)
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TIPS Did You Know?
The global positioning system 

(GPS) is a direct benefit of space 

technology. It uses satellites to 

triangulate your position nearly 

anywhere on the planet (you must 

have clear access to the sky). It 

was started 40 years ago by the 

U.S. Department of Defense for 

military purposes, but is now a 

backbone of travel systems across 

the globe.

Try This!
By default, all tags showing where 

your photos have been placed 

appear on the map when the map 

is in Places view. That can be 

confusing. Change the display to 

only show the visible images by 

clicking Show Only Media Visible 

on Map at the bottom of the map.

Did You Know?
Petrified wood is heavy! Its wood 

has been replaced by agate-like 

rock so that it weighs nearly 200 

pounds per cubic foot. Even a 

small log can therefore weigh 

over a ton! It is illegal to remove 

petrified wood from the park; 

doing so will net you a large fine 

and a bad back.

 Places now displays your placed 
images.

@  To see where the images are on a 
map, click the Map icon to 
display the map.

# Double-click a photo to show 
where it is on the map.

$ Double-click the icons on the 
map to display the photos at that 
location.

A A marker now appears 
on the map where the 
photos were taken. The 
number of photos for 
this location shows up 
on the marker.

B The photos gain a small 
Places icon at the upper 
right to show they have 
been placed.

! Click Done when you 
have placed all the 
photos you want to 
place.

#9
(continued)
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 The Add New Event panel 
appears.

3 Type a name for the event.

4 Type a description for the event.

1 Click a folder in the Media view 
that holds photos from an event.

2 Click Add Event.

Much of life is based around events, from family events 
such as births, graduations, and weddings, to public 
events such as parades and fairs. One way of organizing 
your images is to collect them into groups by events, and 
Photoshop Elements Organizer enables you to do exactly 
that. A reminder: These groups are collections that simply 
organize your photos; they do not move them on your 
hard drive.

The event being organized here is the Kinetic Sculpture 
Race in Humboldt County in far northern California. This is 
a unique, public event that occurs every year over the 

Memorial Day weekend. Participants create remarkable 
machines that can only be human powered and are put 
together with quite creative and artistic designs. Over the 
three-day event, racers must travel between Arcata, 
Eureka, and Ferndale while traversing county roads, sand 
dunes, and even a passage across water. The race is done 
in three sections, with a camp out for racers between 
each. Judges even check to be sure racers have sleeping 
bags and toothbrushes on board for each participant 
before they can race!

Work with EVENTS VIEW
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TIPS Did You Know?
Everything you shoot has a date 

built into the metadata of the 

image file as saved by the camera. 

Organizer already recognizes that 

and even stacks all your images by 

date if you go to Events, then slide 

the Events/Dates switch to change 

it to Dates.

Try This!
If you know you want to place an 

entire folder of images into an 

event, you can select all the images 

before you click Add Event. If you 

make that selection first, all your 

selected images will already be in 

the content section of the Add 

New Event panel when the Add 

New Event panel opens.

Did You Know?
The Humboldt County Kinetic 

Sculpture Race is the original 

kinetic sculpture race and bills 

itself as the Kinetic Grand 

Championship. It started out over 

40 years ago when a Ferndale 

sculptor enhanced the look of his 

son’s tricycle, and an artist friend 

challenged him to a race. Today, 

racers get prizes for many things, 

from the expected race winner to 

artistic merit to the first racer to 

break down leaving town.

9 Ctrl/⌘+click photos to select 
individual images, or click a 
photo and then Shift+click the 
last image in a group to select 
photos in order.

 Optionally, press Ctrl/⌘+A to 
select all photos.

0 Click and drag the selected 
photos to include them in the 
event.

5 Set the start and end 
dates of the event.

6 Click the calendar icon 
to get a calendar.

7 Click the month and 
year to get a drop-
down menu so you can 
select each.

8 Click the day of the 
month.
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 You return to the main Media 
view.

# Click Events.

A Your photos now appear in the 
content area of the Add New 
Event panel.

! Click a photo and then click the 
trash can icon to remove it from 
the content area.

@ Click Done.

This is the third of the three main collections of images 
available to you in Organizer: People, Places, and Events. 
These three categories appear prominently at the top of 
the Organizer interface along with the main way of seeing 
all your images, Media. Media is simply everything in 
Organizer and is not a collection of specific images based 
on specific criteria the way that People, Places, and Events 
are. Media is organized by the way you put your original 
images into folders that appear in the Folders view at the 

left or the directory tree showing the exact location of the 
folder on your hard drive, also available on the left.

Some photographers are more detail oriented than others 
and will spend more time developing these collections. 
The advantage of doing that is that you will have a better 
system for accessing unique images in your photographs. 
The disadvantage is, of course, the time needed to do 
that. No one approach works for every photographer.

Work with EVENTS VIEW (continued)
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TIPS Did You Know?
At the bottom right of an event 

stack is a small i icon. Click it to 

see the full description for the 

event in a small display with the 

stack. This display can be very 

helpful if you have put in a lot of 

information about an event so that 

you can see it quickly.

Try This!
To access a full-screen mode for 

your event and play it as a slide 

show, go to the View menu and 

select Full Screen. You can also 

access this with the F11 key on 

most computers, though this 

depends on how the function keys 

are set up for use on your 

computer. This Full Screen mode 

can be used throughout Organizer 

to fill your screen with photography, 

not a computer program.

Did You Know?
When event stacks are displayed 

in Events, a calendar panel appears 

on the right. It can be turned on 

and off with the calendar icon 

below. This panel lets you change 

what event stacks are being 

displayed by selecting specific 

years and even months as needed.

 The All Events screen for Events 
appears. All events that you have 
defined and described as detailed 
in this task appear here.

 Your a stack of images in 
Events now represents 
your event.

$ Move your cursor slowly 
across a stack, without 
clicking, to display the 
images in the stack.

% Right-click when you get 
to an image you want, 
then use the context-
sensitive menu to set it as 
the “top” photo for the 
event or to choose other 
options.

^  Double-click the stack to 
open it.

& Click All Events.

#10
(continued)
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 The Create Keyword Tag dialog 
box appears.

5 Choose a category.

6 Type a name for your keyword 
tag.

7 Choose an icon if desired by 
clicking Edit Icon.

Using Keyword Tags

1 Click the Keyword/Info icon to 
open the Keyword Tags panel of 
Organizer.

2 For more space, close the folders 
panel at the left by clicking Hide 
Panel.

3 You can start with the Keyword 
Tags listed.

4 Click the large green plus sign at 
the top right of the panel.

In Organizer, you can connect special words to your 
images called keywords. You can be as specific as you 
want with keywords to allow you to quickly search for 
specific photos. In previous versions of Organizer, you 
could do only keyword tags. In Photoshop Elements 11, 
you can now type specific keywords for your photos 
without using tags.

You have to spend the time attaching keywords to your 
photographs in order to use keywords. You may know that 
you have a photograph of a bear somewhere in your 

collection, but if you have not associated the keyword 
“bear” with that image, it could be very hard to find.

You can simply add keywords to large groups of selected 
pictures, or, if you want to be able to really find specific 
images, you can add a lot of very specific keywords to 
individual pictures.

The photos seen here are from the Kinetic Sculpture Race. 
Keywords for them could be as specific as individual 
names for the unique vehicles plus other details or as 
generic as “parade.” This depends on your needs.

USE KEYWORDS to tag your images
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TIPS Try This!
You can search using Keywords 

and Keyword Tags over your 

entire collection of images or just 

in a specific folder. To limit a 

search to specific items in an 

album, click the album first. To 

search throughout your images, be 

sure you have checked All Media 

just under Media. If All Media is 

not visible, you are showing all 

media.

Important!
Pick keywords that help you find 

your photos. Your keywords will 

be unique to your type of 

photography. Adding keywords 

that others use but do not fit your 

images will make your searches 

confusing. Ask yourself, “What do 

I need to find?” in order to create 

keywords that work for you and 

your needs.

Customize It!
You can add as much or as little 

information as you want to 

keyword tags. The Create 

Keyword Tag dialog box includes 

the option to add notes such as a 

specific address for a location. 

Notes are not requirements, only 

options that some photographers 

use frequently, and others not at 

all. Use what you need and what 

works for you.

 To search for images by keyword, 
be sure you are displaying all 
photos. When you are in the Media 
view, click All Media if it is visible 
just below Media.

0 Type a keyword or set of keywords 
into the search bar.

! Photoshop Elements finds the 
images and displays them as you 
type.

A A new keyword tag appears 
in the category you chose in 
step 5.

8 Select the photos that need 
this keyword.

 The selected photos have a 
blue frame around them.

9 Clicking and dragging the 
selected photos onto the tag 
means they gain that tag.

 You can also put a keyword 
on a specific photo by 
clicking and dragging a tag 
to a photo or group of 
selected photos.
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4 Type your keywords in the Image 
Keywords box.

 You can also type multiple 
keywords at the same time by 
separating them with commas.

5 Click Add to add the keywords to 
the photo or photos.

Using Keywords

1 Click one or more photos to add 
keywords to. Ctrl/⌘+click photos 
to select multiple images, or press 
Ctrl/⌘+A to select all photos.

2 Click the Keyword/Info icon to 
show the Keyword Tags panel.

3 Click Show/Hide Panel to show or 
hide the left panel to change how 
much room your photos have to 
display.

Keyword Tags are a simplified version of keywords that 
have been with Photoshop Elements for a long time. They 
make keywording drag-and-drop simple, but they get 
rather unwieldy if you want to do extensive keywording. 
Now you can type in keywords directly for heavy use of 
keywords.

It is important to understand that you can add keywords 
to one picture and only one picture, to a few, or to 
hundreds. Keywords enable you to be very specific, down 
to putting a specific name on something that appears only 

in one picture. They also enable you to be broader in your 
approach and put a single word across a whole group of 
pictures so that you can find that group again. Keywords 
work across all pictures within Organizer so that you can 
find pictures throughout Organizer by simply searching for 
keywords in the search bar at the top of the interface.

The best time to add keywords is when you first import 
pictures into Photoshop Elements. At that time, you 
remember the most about your pictures.

USE KEYWORDS to tag your images (continued)
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TIPS Try This!
You can quickly narrow a search 

down to very specific photos if 

you have many keywords for each 

photo. To do this, type your 

keywords in the search box at the 

top of Organizer and separate 

each keyword with a comma. 

Organizer then looks for images 

that include all the keywords and 

only those keywords.

Did You Know?
Professional photographers 

frequently use extensive keywords 

to help them find photographs in 

their files. When a client wants 

something specific, such as young 

people at a Fourth of July parade, 

keywords help find photos with 

those criteria. Keywords would 

include “young people,” “Fourth of 

July,” “parade,” and so on.

Try This!
You can type a list of keywords 

based on common descriptions of 

things in your photos. You can then 

import this list into Photoshop 

Elements by clicking the arrow next 

to the large green plus sign under 

Keyword Tags and selecting From 

File. This file must be an XML 

(Extensible Markup Language) file. 

You can save a Word file as an 

XML file for this purpose.

8 Click Information to swap the 
Keyword Tags panel for a simpler 
panel that accepts direct input of 
image keywords.

B Information displays information 
about your photo, including 
metadata about shutter speed, 
f-stop, and so on.

A The keyword now 
appears as a new 
keyword tag.

6 Click a photo.

7 The photo’s keywords 
appear in the Image 
Keywords box.

#11
(continued)
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